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Introducing Simscape Multibody
Software

Simscape Multibody software models, simulates, and visualizes mechanical systems,
together with Simulink® and MATLAB®.

* “Product Overview” on page 1-2

+ “Related Products” on page 1-3

* “Simulate Conveyor Belt Model” on page 1-5

* “What You Can Do with Simscape Multibody Software” on page 1-16
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Product Overview

1-2

In this section...

“Product Definition” on page 1-2

“Mechanical Simulation and Physical Modeling” on page 1-2

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Product Definition

Simscape Multibody software is a block diagram modeling environment for the
engineering design and simulation of rigid multibody machines and their motions, using
the standard Newtonian dynamics of forces and torques.

With Simscape Multibody software, you can model and simulate mechanical systems with
a suite of tools to specify bodies and their mass properties, their possible motions,
kinematic constraints, and coordinate systems, and to initiate and measure body motions.
You represent a mechanical system by a connected block diagram, like other Simulink
models. You can also incorporate hierarchical subsystems.

The visualization tools of Simscape Multibody software display and animate 3-D machine
geometries, before and during simulation.

Mechanical Simulation and Physical Modeling

Simscape Multibody software is based on the Simscape software, the platform product for
the Simulink Physical Modeling family, encompassing the modeling and design of systems
according to basic physical principles. Simscape software runs within the Simulink
environment and interfaces seamlessly with the rest of Simulink and with MATLAB.
Unlike other Simulink blocks, which represent mathematical operations or operate on
signals, Simscape blocks represent physical components or relationships directly.




Related Products

Related Products

In this section...

“Required Products” on page 1-3

“Other Related Products” on page 1-4

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

Required Products

You must have current versions of the following products installed to use Simscape
Multibody software:

+ MATLAB

¢ Simulink

* Simscape

Simscape Multibody Visualization Requirements

The Simscape Multibody visualization window requires Silicon Graphics OpenGL®
graphics support on your system in order to display and animate mechanical systems.

You can improve your speed and graphics resolution by adding a graphics accelerator
hardware card to your system. Animation of simulations is sensitive to central processor
and graphics card speed and memory. Experiment to find a reasonable compromise
between quality and speed for your system.

STL Graphics Files for Customized Body Shapes

To switch from the Simscape Multibody visualization default body surface geometries to
customized body shapes, you need a stereolithographic (STL) graphics file for each
customized body. You can obtain these from computer-aided design (CAD) assemblies via
the Simscape Multibody Link exporter, from graphical editors, or by manual creation.

Support for Recorded Animations

You can record simulation animations in Microsoft Audio Video Interleave® (AVI) format
using the Simscape Multibody visualization. To play back AVI files, you need an AVI-
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compatible media application. MATLAB has an internal movie player compatible with AVI.
You can also use an external AVI-compatible player.

If you want to compress your Simscape Multibody AVI recordings, you need the Indeo 5
codec installed on your system to record them. Your AVI player might also require this
codec to view compressed recordings.

Other Related Products

The related products listed on the Simscape Multibodyproduct page at the MathWorks
Web site include toolboxes and blocksets that extend the capabilities of MATLAB and
Simulink. These products will enhance your Simscape Multibody experience in various
applications.

Simscape Multibody Link Utility

The Simscape Multibody Link utility interfaces MATLAB with external mechanical
applications such as CAD platforms. It generates Physical Modeling XML files that you
can import to automatically generate Simscape Multibody models representing CAD
assemblies. See the Simscape Multibody Link documentation.

Physical Modeling Product Family

Use the Physical Modeling product family to model physical systems in Simulink. In
addition to Simscape Multibody software, it includes:

* Simscape, the platform and unifying environment for Physical Modeling products
» Simscape Electrical™, for modeling and simulating electronic systems

* Simscape Driveline™, for modeling and simulating drivetrain systems

* Simscape Fluids™, for modeling and simulating hydromechanical systems

» Simscape Electrical, for modeling and simulating electrical power systems

1-4
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Simulate Conveyor Belt Model

Simulate Conveyor Belt Model

In this section...

“What the Example Represents” on page 1-5

“What the Example [llustrates” on page 1-6
“Opening the Model” on page 1-8

“Running the Model” on page 1-10

“Modifying the Model” on page 1-11

“Visualizing and Animating the Model” on page 1-12

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

What the Example Represents

This example model uses a few blocks in the library to simulate a simple machine with
feedback control. You will see how Simscape Multibody features build upon standard
Simulink features to model a mechanical system.

The example model simulates a conveyor belt loading mechanism. A simple controller (not
shown), with a sensor and an actuator, guides the mechanism with a saturation limit and
anti-windup logic for the applied torque. You can adjust the controller and set the
stopping point for the pusher.
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Conveyor Loader Mechanism

What the Example lllustrates

The conveyor mechanism example illustrates some important Simscape Multibody
features:

Representing bodies and degrees of freedom with Body and Joint blocks, respectively
Using Simscape Multibody blocks with normal Simulink blocks

Feeding Simulink signals to and from Simscape Multibody blocks with Actuator and
Sensor blocks, respectively

Encapsulating groups of blocks into subsystems



Simulate Conveyor Belt Model

* Visualizing and animating a mechanism by its component bodies

Caution You might want to make modifications to this example model. To avoid errors,

* Do not attempt to connect Simulink signal lines directly to Simscape Multibody blocks
other than Actuators and Sensors.

* Keep the collocation of the Body coordinate system origins on either side of each
assembled Joint to within assembly tolerances.

Saving modified example models in a different folder from the examples is
recommended.

The following figure shows a detailed schematic of the conveyor belt loading mechanism.
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To get started quickly with the conveyor example model, follow either of these steps:

* Enter mech

conveyor at the MATLAB command line.

» If you are working with the MATLAB Help browser, click the model name
mech_conveyor here.


matlab:mech_conveyor

Simulate Conveyor Belt Model

The Block Diagram Model

The block diagram model opens in a model window.
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What the Model Contains

Here are some critical features of the model:

Simple conveyor loader guided by feedback controller with saturation limit
and anti-windup logic. Centroller actuates Revolute crank to move Pusher

to user-set Reference Position.
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Conveyer Mechanism

* Ignore the Position Controller, Joint Sensor, and Joint Actuator blocks for a moment.
Note that the loading mechanism follows the tree of bodies and joints shown in the
figure, “Conveyor Loader Mechanism” on page 1-6:

* There are four rotating link bodies and one sliding pusher body, as well as three
ground points on the immobile mounting represented by Ground blocks. Double-
click the Body and Ground blocks to see their dialog boxes.
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* The pusher slides and the links rotate relative to one another and to the ground
points on the mounting. There are seven apparent degrees of freedom (DoFs) in the
system, represented by seven Joints, but the geometry constrains the motion to one
actual DoF. Double-click the Revolute blocks to see how rotational DoFs are
expressed in their dialog boxes.

* The Prismatic block expresses the linear motion of Pusher relative to Ground 2.
The Revolute block expresses the angular motion of Link4 (the crank of the whole
mechanism) relative to Ground 1.

The Joint Sensor detects the position of Pusher via the Prismatic block. The Joint
Actuator applies torque to Link4 via the Revolute block. Double-click the Sensor and
Actuator blocks to view how the mechanical motions and forces/torques are
transformed into Simulink signals.

The Position Controller subsystem converts the Pusher position information into a
feedback signal to actuate Revolute and thus Link4. You can open the Position
Controller block to view this subsystem, which is made of normal Simulink blocks.

® = Ap+Bu
y=Cx+Du
im W)
*® = HAe+Bu ® = Ap+Bu
Paos tion y=Cx+Du P y=Cu+Du » f LN
= Torgue
H_inf Controller Loops haping W eight Satur ation
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Reference | —
Prefitter Limit inputs <

Equilibr ium

The Reference Position block gives you control over the stopping position of the
pusher by modulating the control signal that actuates Revolute. Maintaining the initial
pusher position requires a fixed torque on Revolute.

Open the Scope block. You can view both the Pusher position in millimeters (mm)
relative to Ground 2 as the Measured Position plot and the torque in newton-meters
(N-m) applied to Link4 relative to Ground 1 as the Torque plot.

Running the Model

You can now run the model as it is when you first open it:
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3

In the Simulation menu, select Configuration Parameters. The Configuration
Parameters dialog box appears. Select the Solver node:

a The preset Stop time is inf, so the simulation keeps running once you start it.
You should leave it at inf and stop the simulation manually the first few times
you run it.

Later you can apply a finite stop time (in seconds) if you want.
b Leave the Solver options entries at default values and close the box.

From the Simulation menu, select Start. In Microsoft Windows®, you can also click
the Start button in the model window toolbar.

The measured position of the pusher and the torque applied to maintain that position
start and remain essentially constant in the Scope plots. The applied torque is
adjusted to maintain the initial pusher position.

Measured Position

To see greater detail at the simulation start, stop the simulation before the time
passes 20 seconds and zoom in on the Scope plots.

Modifying the Model

Here is a modification of the example you can try. It illustrates the simple controller that
you can adjust to change the motion of the pusher.

To make these modifications, it is best to close and restart the example.

1-11
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Changing the Pusher Reference Position

The Reference Position block is actually a Simulink Slider Gain block (from the Simulink
Math Library) and controls where the pusher comes to rest.

You can adjust the Reference Position block to change where the pusher stops:
1 Open the Reference Position block. You see an adjustable slider to set the position of

the pusher's rest point.

2 Enter values in the Low and High fields to set the lower and upper limits of the
allowed slider range. The defaults in this example are 0 and 0.2, with implied units
of meters (m).

3 Enter a value in the central field to set the pusher stopping point, which you can also
adjust by clicking and dragging the slider between the lower and upper limits. The
default is 0 (meters).

You can apply changes to the reference position to the simulation in two ways:
* Reset the Reference Position block first, then start the example. You see the pusher

trajectory track differently now, toward the new stopping point.

» Start the example with the Reference Position block open and move the slider up and
down as the simulation runs. Watch the Scope. The measured position and necessary
torque change to follow the new reference position.

Visualizing and Animating the Model

Another modification you can make illustrates a powerful Simscape Multibody feature,
visualization of a mechanism and animation of its simulated motion.

You can visualize and animate the conveyor mechanism by opening the Simscape
Multibody visualization window. This window lets you display the bodies in two standard
abstract forms:

» Equivalent ellipsoids use the inertia tensors and masses of the bodies. Each body has a
unique homogeneous ellipsoid equivalent to it in mass and inertia tensor.

* Convex hulls use the attached Body coordinate systems (CSs) of the bodies to define a
shape outlined by the CS origins.

Convex Hulls

First try visualizing the conveyor with bodies displayed as convex hulls:
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From the Simulation menu, select Model Configuration Parameters. The
Configuration Parameters dialog box appears.

Select the Simscape Multibody 1G node. In the Visualization area, select the
Display machines after updating diagram and Show animation during
simulation check boxes.

Leave the other defaults as they are and close the dialog. From the Edit menu, select
Update Diagram.

A Simscape Multibody visualization window appears, displaying the conveyor at rest
in its initial state.

The bodies are displayed in the default geometry, as convex hulls. The bodies and
Body coordinate system axis triads are also displayed as defaults.
Change Reference Position to a nonzero value such as 0.1 or 0. 2.

Restart the simulation. The window animates the conveyor in motion. You can
compare this motion to the plots in the scope.
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6 Click a body in the visualization window. In the model window, the corresponding
Body block is highlighted in red. The block name appears at the lower left of the
visualization window.

7 Examine the visualization window menus and tool bar.

Here, you can reconfigure the display properties: bodies, Body CS axis triads, colored
fill-in body surface patches connecting Body CSs on the same body, and viewpoint
orientation.

8 Leave the visualization window open for the next set of steps.
Equivalent ellipsoids
Now visualize the conveyor with bodies displayed as ellipsoids:

1 From the Model menu in the menu bar, select Body Geometries > Ellipsoids, so
that a check mark appears beside the menu entry.

1-14
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The display in the visualization window changes. The conveyor appears at rest in its
initial state but with the bodies displayed as equivalent ellipsoids.

Restart the simulation. The viewer now animates the conveyor in motion.

Use the menus to experiment with the visualization settings. The toolbar contains
most of these functions as well.

oy
While the animation is running, open the Reference Position block and move the

slider up and down. In addition to what you can see in the Scope plots, the window

directly animates the pusher trajectory in space as the mechanism responds to your
adjustment.
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What You Can Do with Simscape Multibody Software

1-16

In this section...

“About Simscape Multibody Software” on page 1-16

“Modeling Mechanical Systems” on page 1-16

“Bodies, Coordinate Systems, Joints, and Constraints” on page 1-17
“Sensors, Actuators, Friction, and Force Elements” on page 1-18
“Simulating and Analyzing Mechanical Motion” on page 1-19
“Visualizing and Animating Models” on page 1-20

Warning This content is specific to Simscape Multibody First Generation software. First-
generation features are slated to be deprecated and should be avoided.

About Simscape Multibody Software

Simscape Multibody software is a set of block libraries and mechanical modeling and
simulation tools for use with Simulink. You connect Simscape Multibody blocks to normal
Simulink blocks through Sensor and Actuator blocks.

The blocks in these libraries are the elements you need to model mechanical systems
consisting of any number of rigid bodies, connected by joints representing translational
and rotational degrees of freedom. You can represent mechanical systems with
components organized into hierarchical subsystems, as in normal Simulink models. You
can impose kinematic constraints, apply forces/torques, integrate the Newtonian
dynamics, and measure resulting motions. See “Simulate Conveyor Belt Model” on page
1-5.

Glossary Terms For an explanation of important terms, see the Glossary.

Modeling Mechanical Systems

These are the major steps you follow to build and run a model representation of a
machine:
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1  Specify on page 1-17 body inertial properties, degrees of freedom, and constraints,
along with coordinate systems attached to bodies to measure motions and forces.

2 Set up on page 1-18 sensors to record motions and forces, as well as actuators and
force elements to initiate motions and apply forces, including continuous and
discontinuous friction.

3  Start on page 1-19 the simulation, calling the Simulink solvers to find the motions of
the system, while maintaining any imposed constraints. You can also generate,
compile, and run generated code versions of your models.

4 Visualize on page 1-20 the machine while building the model and animate the
simulation while running it, using the Simscape Multibody visualization window.

Bodies, Coordinate Systems, Joints, and Constraints

You model bodies with Body blocks specified by their masses, inertia tensors, and
attached Body coordinate systems (CSs). You connect the bodies to one another with
joints representing the possible motions of bodies relative to one another, the system's
degrees of freedom (DoFs). You can impose kinematic constraints on the allowed relative
motions of the system's bodies. These constraints restrict the DoFs or drive the DoFs as
explicit functions of time.

The Simscape Multibody interface gives you many ways to specify CSs, constraints/
drivers, and forces/torques. You can

» Attach Body CSs to different points on Body blocks to specify local axes and origins for
actuating and sensing.

» Take Joint blocks from the Simscape Multibody library or extend the existing Joint
library by constructing your own custom Joints.

* Use other Simulink tools as well as MATLAB expressions.
Defining Local Coordinate Systems

Simscape Multibody models automatically contain a single inertial reference frame and
CS called World. You can also set up your own Local CSs:

* Grounded CSs attached to Ground blocks at rest in World but displaced from the
World CS origin

* Body CSs fixed on and moving rigidly with the bodies

1-17
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Kinematic Constraints

Specifying kinematic relations between any two bodies, you can constrain the motion of
the system by connecting Constraint blocks to pairs of Bodies. Connecting Driver blocks
applies time-dependent constraints.

Sensors, Actuators, Friction, and Force Elements

Sensors and Actuators are the blocks you use to interface between normal Simulink
blocks and Simscape Multibody blocks. Force Elements represent internal forces that
require no external input.

* Sensor blocks detect the motion of Bodies and Joints.

Sensor block outputs are Simulink signals that you can use like any other Simulink
signal. You can connect a Sensor block to a Simulink Scope block and display the
motions in a system.

You can feed these Sensor output signals back to a Simscape Multibody system via
Actuator blocks, to specify forces/torques in the system.

* Actuator blocks specify the motions of Bodies or Joints.

They accept force/torque signals from Simulink and can apply forces/torques on a
body or joint from these signals. The Simulink signals can include Sensor block
outputs fed back from the system itself.

They detect discrete locking and unlocking of Joints to implement discontinuous
static friction forces.

They specify the position, velocity, and acceleration of bodies or joints as explicit
functions of time.

They prepare a system's initial kinematic state (positions and velocities) for the
forward integration of Newtonian dynamics.

Force Elements model internal forces between bodies or acting on joints between bodies.
Internal forces depend only on the positions and velocities of the bodies themselves,
independent of external signals.

1-18
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Simulating and Analyzing Mechanical Motion

Simscape Multibody software provides four modes for analyzing the mechanical systems
you simulate: Forward Dynamics, Trimming, Inverse Dynamics, and Kinematics. You can
also convert any mechanical model, in any mode, to a portable, generated code version.

Mathematical Determination of Rigid Body Motion

For the forward dynamics to be mathematically solvable, the system must satisfy certain
conditions:

* The masses and inertia tensors of all bodies are known.
» All forces and torques acting on each body at each instant of time are known.

* Any kinematic constraints among DoFs are specified as constraints among positions
and/or velocities alone. If the constraints are mutually consistent and are fewer in
number than the DoFs, the system's motion is nontrivial and can be found by
integration.

 Initial conditions (initial positions and velocities) are specified and consistent with all
constraints.

For inverse dynamic analysis, you specify the motions instead and obtain the forces/
torques needed to produce those motions.

Forward Dynamics, Trimming, and Linearization

In the Forward Dynamics mode, a Simscape Multibody simulation uses the Simulink suite
of ordinary differential equation (ODE) solvers to solve Newton's equations, integrating
applied forces/torques and obtaining the resulting motions. The ODE solvers project the
motion of the DoFs onto the mathematical manifold of the kinematic constraints and yield
the forces/torques of constraint acting within the system.

Trimming
The Trimming mode allows you to use the Simulink trimming features to search for steady

or equilibrium states in mechanical motion. These states, once found, are